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Neu: ACDCA-Mitgliedschaft 

 
Das ACDCA (Austrian Center for Didactics of Computer Algebra) wurde Ende der 80er 
Jahre gegründet und ist seither eine der treibenden Kräfte für den Einsatz von CAS in der 
Mathematikausbildung. Dieser Verein wurde kürzlich umstrukturiert und bietet nun allen 
Interessierten die Mitgliedschaft und damit die Gelegenheit zur Mitwirkung an. Bitte in-
formieren Sie sich auf der Homepage des ACDCA über die Aufgaben und Ziele des 
ACDCA. 
Info und Beitrittserklärung finden Sie auf 

http://rfdz.ph-noe.ac.at/acdca.html 

Hier steht auch die verbesserte und ergänzte Version der „Dynamischen Systeme“ zum 
Download bereit: 

http://rfdz.ph-noe.ac.at/acdca/materialien.html 

Latest News:  
You are invited to download  
 

Dynamic Systems on Various Platforms - An Excursion from  
Environment & Tourism to Strange Attractors! (113 pages) 

 
http://rfdz.ph-noe.ac.at/acdca/materialien.html 

------------------------------------------------------------------------------------------------------------ 
Prof. Paditz from HTW Dresden informed that the complete proceedings of two MEC21-
Conferences (Dresden 2009 with 147 contributions and Grahamstown 2011 with 73 con-
tributions) are available as download at  

http://nbn-resolving.de/urn:nbn:de:bsz:14-qucosa-79236 
http://nbn-resolving.de/urn:nbn:de:bsz:14-qucosa-79243 

------------------------------------------------------------------------------------------------------------ 
STATISTICS with TI-Nspire 

I am very happy that Guido Herweyers – our Flemish Statistics expert – permitted publi-
cation of his 50 pages paper. I tried to translate from Flemish (Dutch) into English (my 
wife is from Dutch origin) and you will find his paper divided in some parts in this and in 
the next DNLs. TI-Nspire has some very nice features especially for statistics. 
 

Attend TIME2012 in Tartu, Estonia 
July 10-14, 2012 

http://time2012.ut.ee/ 

List of lectures and workshops, which have been accepted until now is on pages 
45 and 46. Don’t miss the opportunity to meet CAS-experts from all continents 
and register! 
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Liebe DUG-Mitglieder, 

Leider bin ich mit diesem DNL etwas zu 
spät dran weil ich die Arbeit an einigen 
Artikeln unterschätzt habe und die Vorbe-
reitung der TIME 2012 immer wieder Zeit 
in Anspruch genommen hat. 

Im letzten DNL wurde das TI-Nspire-
Programm TRIGO vorgestellt. Herr van 
Lantschoot hat eine verbesserte Version 
geschickt, herzlichen Dank dafür. 

Es freut mich besonders, dass Philip 
Todd einen Artikel beigetragen hat, in dem 
er das Zusammenwirken seines schönen 
Programms Geometry Expressions mit TI-
NspireCAS demonstriert. Dass dies auch 
mit DERIVE (u.a. CAS) möglich ist, habe ich 
zu zeigen versucht. Philip wird auch an der 
TIME 2012 mitwirken. 

Ludwig Heinrichs Cubus-Simus-Aufsatz 
hat auch für mich eine Eigendynamik be-
kommen. Viel Information war im Internet 
zu finden. Einige „Challenges“ für Sie sind 
noch offen! 

Ich kann mir denken, dass Dietmar 
Oertel schon ungeduldig auf die Veröffent-
lichung seiner umfangreichen Untersuchun-
gen im Bereich der Primzahlen und der Tay-
lorreihen wartet. Seine Unterlagen umfas-
sen jeweils ca 60-70 Seiten und eine sinn-
volle Zusammenfassung braucht seine Zeit, 
aber ich bin schon dabei. 

Der im letzten DNL angekündigte Vor-
schlag von Klaus Körner muss auf den 
DNL#86 warten wie auch interessante 
Informationen für mu-Math-Kenner.  

Von der Webseite des ACDCA können 
Sie eine verbesserte und erweiterte Versi-
on meines Aufsatzes zu den Dynamischen 
Systemen (ca 110 Seiten) beziehen. Beach-
ten Sie bitte unsere Einladung auf der In-
fo-Seite. 

Schließlich finden Sie die Liste der bis-
her angenommenen Vorträge für die TIME 
2012, in deren Rahmen auch ein DUG-
Treffen stattfinden wird. 
 

Dear DUG Members, 
It is really a pity that I am a little bit 

late with this DNL. Actually I underesti-
mated work on some contributions and 
preparation of TIME 2012 needed some 
time, too 

The TI-Nspire-program TRIGO was 
presented in the last DNL.  Erik van 
Lantschoot, the author of TRIGO sent an 
improved version, many thanks for this. 

I am very happy that Philip Todd pro-
vided an article demonstrating cooperation 
of his excellent Geometry Expressions pro-
gram with TI-NspireCAS. I try to show 
that this is also possible with DERIVE (and 
other CAS). Philip will present a lecture and 
a workshop at TIME 2012. 

Ludwig Heinrich’s Cubus Simus contri-
bution got an interesting self dynamics for 
me. Much information could be found in the 
web. Some “challenges” are still remaining 
for you. 

I am quite sure that Dietmar Oertel is 
is anxious for publication of his extensive 
investigations in the field of prime numbers 
and Taylor series. His papers comprise 
about 60-70 pages each, so preparing a 
meaningful summary needs time, but I am 
busy … 

I announced a proposal from Klaus 
Körner in the last DNL. It must wait for 
DNL#86 – together with interesting infor-
mation for my-Math-experts. 

You are invited to download a paper on 
Dynamic Systems on Various Platforms 
(~100 pages) from the ACDCA-website. Its 
URL is given on the information page. 

Finally you can find the list of the ac-
cepted lectures and workshops for TIME 
2012 where we will have a DUG-Meeting, 
too. 
 Viele Grüße, Best regards 
 
 
 

Download all DNL-DERIVE- and TI-files from 
http://www.austromath.at/dug/ 
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The DERIVE-NEWSLETTER is the Bulle-
tin of the DERIVE & CAS-TI User Group. 
It is published at least four times a year 
with a content of 40 pages minimum. The 
goals of the DNL are to enable the ex-
change of experiences made with DERIVE, 
TI-CAS and other CAS as well to create a 
group to discuss the possibilities of new 
methodical and didactical manners in 
teaching mathematics. 
 

Editor: Mag. Josef Böhm 
D´Lust 1, A-3042 Würmla 
Austria 
Phone: ++43-(0)660 3136365 
e-mail: nojo.boehm@pgv.at 

Contributions: 
Please send all contributions to the Editor. 
Non-English speakers are encouraged to 
write their contributions in English to rein-
force the international touch of the DNL. It 
must be said, though, that non-English 
articles will be warmly welcomed nonethe-
less. Your contributions will be edited but 
not assessed. By submitting articles the 
author gives his consent for reprinting it in 
the DNL. The more contributions you will 
send, the more lively and richer in contents 
the DERIVE & CAS-TI Newsletter will be. 
 
 
Next issue:  June 2012 
 

 
Preview:  Contributions waiting to be published  
 Some simulations of Random Experiments, J. Böhm, AUT, Lorenz Kopp, GER 
 Wonderful World of Pedal Curves, J. Böhm, AUT 
 Tools for 3D-Problems, P. Lüke-Rosendahl, GER 
 Hill-Encription, J. Böhm, AUT 
 Simulating a Graphing Calculator in DERIVE, J. Böhm, AUT 
 Do you know this? Cabri & CAS on PC and Handheld, W. Wegscheider, AUT 
 An Interesting Problem with a Triangle, Steiner Point, P. Lüke-Rosendahl, GER 
 Overcoming Branch & Bound by Simulation, J. Böhm, AUT 
 Graphics World, Currency Change, P. Charland, CAN 
 Cubics, Quartics – Interesting features, T. Koller & J. Böhm, AUT 
 Logos of Companies as an Inspiration for Math Teaching 
 Exciting Surfaces in the FAZ / Pierre Charland´s Graphics Gallery 
 BooleanPlots.mth, P. Schofield, UK 
 Old traditional examples for a CAS – what´s new? J. Böhm, AUT 
 Truth Tables on the TI, M. R. Phillips, USA 
 Where oh Where is It? (GPS with CAS), C. & P. Leinbach, USA 
 Embroidery Patterns, H. Ludwig, GER 
 Mandelbrot and Newton with DERIVE, Roman Hašek, CZK 
 Tutorials for the NSpireCAS, G. Herweyers, BEL 
 Some Projects with Students, R. Schröder, GER 
 Structures in the Set of Prime Numbers, D. Oertel, GER 
 Dirac Algebra, Clifford Algebra, D. R. Lunsford, USA 
 Treating Differential Equations (M. Beaudin, G. Piccard, Ch. Trottier), CAN 
 A New Approach to Taylor Series, D. Oertel, GER 
 Cesar Multiplication, G. Schödl, AUT 
 Henon & Co; Find your very own Strange Attractor, J. Böhm, AUT 
 Rational Hooks, J. Lechner, AUT 
 Simulation of Dynamic Systems with various Tools, J. Böhm, AUT 
 Using DERIVE to simulate the basic steps of the Q. Shor’s algorithm, N. Urrego, COL 
 
 and others 

Impressum:  
Medieninhaber: DERIVE User Group, A-3042 Würmla, D´Lust 1, AUSTRIA 
Richtung: Fachzeitschrift 
Herausgeber: Mag. Josef Böhm 
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I am very happy that Philip kept his promise to send a contribution for the 
DNL. I appreciate his Geometry Expressions as an extremely powerful geome-
try tool which has a strong built-in CAS. GE can cooperate with all main Com-
puter Algebra Systems. Come and attend Philip’s lecture and workshop at 
TIME 2012. 

Josef 

Approximating Circular Arcs with Cubic Splines 
Philip Todd, Saltire Software  

philt@saltire.com 
 

We use Geometry Expressions and the TI nSpire CAS to find the best 
cubic spline approximation to a quarter circle. 

 
 

1. Introduction 

A problem came from a user of Geometry Expressions recently, which nicely illustrates the power of a 
symbolic geometry system used in conjunction with CAS.  The user wanted to find the control points 
of a Bezier spline which approximated a circular arc of a given angle.  Why would he want to do such 
a thing?  Some software and some machine tools have Bezier spline curves as primitives, but do not 
have circular arcs.  If you want a circle, you need to piece an approximation together out of splines. 

A

B

C

D

E

F

G
H

I

J

t

t

t
t t

t

x0,y0

x1,y1

x2,y2

x3,y3

⇒
X=x0-3·t·x0+3·t2·x0-t

3·x0+3·t·x1-6·t2·x1+3·t3·x1+3·t2·x2-3·t3·x2+t3·x3

Y=y0-3·t·y0+3·t2·y0-t
3·y0+3·t·y1-6·t2·y1+3·t3·y1+3·t2·y2-3·t3·y2+t3·y3  

Figure 1: A cubic spline constructed in Geometry Expressions.  The spline’s para-
metric equation is computed by the software 

A Bezier spline can be readily modeled in Geometry Expressions [1] using the geometric version of de 
Casteljau’s algorithm [2].  We start with control polygon ABCD.  These points are constrained to have 
coordinates (x0,y0), (x1,y1), (x2,y2), (x3,y3).  Point E is constrained to be proportion t along AB.  Point F 
is constrained to be proportion t along BC, and point G is constrained to be proportion t along CD.  
Points H and I are now added and constrained to be proportion t along segments EF and FG.  Finally, 
point J is added and constrained to be proportion t along segment HI. The spline curve is the locus of J 
as t runs from 0 to 1.  
 
An important property of the spline curve is that it is tangential to the control polygon at its ends.  That 
is at t=0, the spline curve is tangential to AB, and at t=1 it is tangential to CD. 
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This property can be readily verified using the TI-Nspire CAS.  Geometry Expressions will automati-
cally generate the parametric equation of the curve (figure 1), and this can be copied (using Copy As / 
TI Nspire) into a TI-Nspire CAS worksheet (figure 2). 
 

 
Figure 2: differentiating the spline curve at t=0 and t=1 shows  

that it is tangential to the control polygon 

The derivatives of the x coordinate and y coordinate with respect to t evaluated at t = 0 show that the 
tangent aligns itself with the segment AB.  Again, the derivatives evaluated at t=1 show that this tan-
gent aligns itself with the segment CD. 
 

 

 
DERIVE screen containing expressions imported from GE and further calculations. 
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2. Center Point on Circle 

In this article, we’ll use a spline to approximate a quarter circle, we’ll refer to general arcs briefly in 
the conclusion. 
We model a quarter circle of unit radius in the first quadrant.  Point A is (0,1) and point D is (1,0).  AB 
is constrained to be perpendicular to the y axis (hence the spline will be horizontal at A).  CD is con-
strained to be perpendicular to the x-axis, and hence the spline is vertical at D. 
It also seems reasonable that we should require our spline to be symmetric about x=y.  We enforce this 
by constraining AB and BC to be the same length: k. 
 

A B

C

D

(0,1)

(1,0)

E

F

G

H

I

J

k

k

K
 

Figure 3: Spline curve with control polygon constrained to guarantee tangency with the unit 
circle at A and D and symmetry about y=x (proportional constraints are hidden for clarity). 

We would like to find a value for k which provides a close approximation to a quarter circle.  One 
approach would be to require the center point of the spline curve to lie on the circle.  The center point 
is the point with parametric location on the curve ½.  This can be easily created in Geometry Expres-
sions by constraining a point’s parametric location on the curve to be ½ (figure 4). 
Geometry Expressions can supply the distance of this point from the origin.  It hardly needs a CAS to 
find a value k such that this distance is 1.  However, as we have one available, we’ll use it.  The result-
ing value of k can be copied from the TI-Nspire CAS back into geometry Expressions.  Comparison 
with a unit circle (figure 5) shows that the fit is quite good.  How good we will see soon. 

A B

C

D

(0,1)

(1,0)

k

k

K

L1
2

⇒
2·(4+3·k)

8

     
Figure 4: Distance of the center of the spline from the origin is measured in Geometry 

Expressions.  The CAS is used to find the value of k which makes this distance 1. 
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A B

C

D

(0,1)

(1,0)

4· -1+ 2
3

4· -1+ 2
3

K

L1
2

⇒ 1

 
Figure 5: Values of k which make point L lie on the unit circle are copied from the 

CAS into Geometry Expressions allowing a visual inspection of the solution. 

2.1 Error Analysis 
To see how far away from the circle our curve lies, we change the location of L from ½ to a generic 
parametric location x (we’re using x for convenience graphing in the TI-Nspire, but at the risk of con-
fusion …x is not the x coordinate of L, but its parametric location on the curve).  Geometry Expres-
sions generates an expression for the distance of this generic point from the origin (figure below). 

A

D

(0,1)

(1,0)K

L

x

⇒ 1+x5· -408+288· 2 +x3· -204+144· 2 +x2· 34-24· 2 +x6· 136-96· 2 +x4· 442-312· 2
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Figure 6: The distance from the origin of point at parametric location x on the spline 
curve is copied from Geometry Expressions into the TI-nSpire CAS. The expression is 

squared, differentiated and solved. 

To find the values of x for which this distance is maximal or minimal, we first copy the expression 
into our CAS.  Optimizing the distance is the same as optimizing its square, so our first step inside the 
CAS is to square the expression, thus getting rid of the square root, and making it more likely that the 
derivative will fit on the page.  Next, differentiate, then solve (figure 6). 

 

We observe that we have extrema at 0, 1/2 (guaranteed by symmetry), 1 and at two other values.  By 
construction, the curve lies on the unit circle at 0, ½ and 1, leaving two points of interest, which are 
symmetric about x = ½ and should, by the symmetry of the figure, lie at the same distance from the 
origin.  This then is the quantity we are interested in.   
 
We simply copy it from the CAS and paste into the Geometry Expressions, replacing x as the paramet-
ric location of point L (figure 7). 
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A

D

(0,1)

(1,0)K

L

3+ 3
6

⇒
71
54

-
2· 2

9

  

A

D

(0,1)

(1,0)K

L

3+ 3
6

⇒ ∼1.0002725

 
Figure 7: Maximal distance of point L is obtained by pasting the solution for x into the parametric 

location constraint for point L.  Numeric display shows the error to be less that 3/10,000 

 
Figure 8: Error graphed as a function of parametric location on the curve. 

An error function may be obtained by subtracting 1 (the radius of the circle) from the distance function 
measured in figure 6.  This is displayed in figure 8.  We observe that this spline curve always errs on 
the side of being too large.  For some applications this may be a benefit, however, we might ask our-
selves whether it would be possible to improve our estimate if we allowed the spline to err both inside 
and outside the circle.  We’ll look at one such curve in the next section. 
 
 
 
3. Equal Area 

One way of ensuring that the spline errs both on the inside and on the outside of the unit circle is to 
insist that the area under the spline is the same as the area under the quarter circle.  To measure the 
area under the spline in Geometry Expressions, you need to create first an arc LM on the spline, then 
draw line segments LK and KM (where K is the origin).  You can then select the segments and the arc 
and create a polygon.  As a final step, you will make sure L and M lie at the start and end of the curve 
by constraining their parametric locations to 0 and 1. 
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A

D

(0,1)

(1,0)K

L

M

         
K L

M

1

0

⇒

1
2

+
3·k
5

-
3·k2

20

 | 
1
2

+
3·k
5

>
3·k2

20

  

 
Figure 9: The area under the spline is measured in Geometry Expressions by creating an arc LM on 

the spline, connecting L and M to the origin and creating a curve-sided polygon KLM.  Finally, L and 
M are constrained to lie at parametric locations 1 and 0 on the curve.  In our CAS, we can find the 

value of k which makes the area under the spline equal to the area under a quarter unit circle. 

Copying the area value into the CAS we can equate it with π/4 (the area under the quarter unit circle), 
and solve for k.  We have two solutions.  The first is numerically close to the value of k which puts the 
center point on the unit circle.  The second is too far removed to be reasonable.  Figure 10 shows what 
they look like: 

B

C

6- -3·(-22+5·π)
3

6- -3·(-22+5·π)
3

K L

M

1

0

⇒
π
4

B

C

6+ -3·(-22+5·π)
3

6+ -3·(-22+5·π)
3

K L

M

1

0

⇒
π
4

 
Figure 10: two solutions yielding the same area under the spline.  Only one is a good 

approximation for the quarter circle! 
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We can paste this value back into Geometry Expressions for k, and let the software derive the distance 
from the origin to the point on the curve at parametric location x (figure 11. This can in turn be copied 
into TI-Nspire for graphing (figure 12). 

B

C

6- -3·(-22+5·π)
3

6- -3·(-22+5·π)
3

K L

M

1

0
N x

⇒ 1+108·x2-15·π·x2-380·x3+60·π·x3+600·x4-105·π·x4-492·x5+90·π·x5+164·x6-30·π·x6+ 66-15·π· -14·x2+44·x3-62·x4+48·x5-16·x6

 
Figure 11: distance to the origin for point at parametric location x on the equiareal approximation 

Analysis of the graph shows that while we have succeeded in reducing the extent to which the ap-
proximate curve overshoots the circle, we have done so at a cost of undershooting it by almost as 
much at the center point. 
 

 
Figure 12: Radius for the equiareal approximation is copied into TI-Nspire from Ge-
ometry Expressions, and plotted next to the area for the central-point approximation. 

However, this suggests an approach for finding a better solution.  Can we find a value of k such that 
the error function undershoots by the same amount that it overshoots?  
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4. Minimizing the maximum error 

Using Geometry Expressions, we can generate a distance function for a point at parametric location x, 
copy this into TI-Nspire CAS and differentiate to find the extrema (figure 13,14). 

B

C

k

k

K

L x

⇒ 1+x5· -24+72·k-54·k2 +x2· -6+6·k+9·k2 +x3· 4+12·k-36·k2 +x6· 8-24·k+18·k2 +x4· 18-66·k+63·k2

 
Figure 13: Distance from the origin of the generic point on the spline with parameter k 

 
Figure 14: Extrema for the curve of figure 12 calculated in the TI-nSpire CAS 

The extrema lie at x = ½ and at two more complicated points.  We can copy and paste the complicated 
points into Geometry Expressions and let it worry about the algebra.  The distance value (figure 15) is 
surprisingly simple.   
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K

L

1
2

⇒
2·(4+3·k)

8

     

K

L

4-12·k+9·k2+(2-3·k)· 12-20·k-3·k2

2· 4-12·k+9·k2

⇒

(-1+3·k)· 8-24·k+12·k2+8·k3+3·k4

(-2+3·k)2

 | 3·k>1
 

Figure 15: Extreme values for the distance from the origin on the spline curve with parameter k 

In the TI-Nspire CAS we define a variable error1 to be the distance at the midpoint subtracted from 1.  
We define error2 to be the distance at the more complicated extremum minus 1.  The CAS will find, 
numerically, a value of k which equates these errors (figure 16). 

 
Figure 16: Numerical solution for k, equating the absolute values of the two errors 

A plot of the error functions (figure 17) reveals that the minimax solution reduces the maximal error 
by over 25% compared with either of the other approximations. 
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Figure 17: Error curve for the minimax solution lies between the error curves for the 

central point solution and the equiareal solution. 

5. Conclusion 

We have looked at modeling a quarter circle.  It is also useful to be able to approximate a general por-
tion of a circular arc.  The development of spline approximations for general arcs yields more compli-
cated formulas, but you can use a similar process, and the CAS can take care of the details.  You do 
need to be careful with the minimax solution as the location of the extremum is complicated enough 
that computing its value can cause problems both for Geometry Expressions and the TI-Nspire.  

A straightforward, but interesting analysis would be to investigate the improvement in accuracy to be 
obtained by approximating a quarter circle by two 45 degree spline approximations.  

Another question would be this:  let’s say we are approximating a full circle by splines, each of which 
approximates one quarter of the circle.  It is a little artificial to insist that the spline meets the circle at 
the axes.  Why not allow the spline to start and finish at a radius slightly below that of the circle being 
approximated.  In this way we could essentially translate the error curve for the center point approxi-
mation vertically down by half its amplitude and achieve a 50% reduction in error. 

The huge benefit of having such powerful software tools as Geometry Expressions and the TI-Nspire 
CAS working together under your direction is that they allow you to explore many more interesting 
variants of a problem than you might be inclined to undertake working only by hand.   

The beauty of Geometry Expressions is that it assists in the mathematical modeling phase of problem 
formulation, allows you to copy the mathematics into your CAS, and then assists in interpreting the 
results, by displaying the solution.  In this way degenerate or nonsensical solutions can be immediately 
differentiated visually from sensible solutions. Such was the case in figure 10, where a picture imme-
diately showed us that one solution involved a spline with a loop. 
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Here are some screenshots from my Geometry Expressions – DERIVE collaboration: 
 

 

 
 
I introduce a slider bar in order to vary the parameter k. 
 

  
 
The blue curve changes when moving the slider, the black line is the circle line and the spline is plot-
ted in red color. 

I don’t show plots of the error curves, it is too obvious that this is no problem for DERIVE (and other 
CAS, of course). 
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Diophantine Polynomials[1] (Part 2) 

Duncan E. McDougall, duncanemcdougall@hotmail.com 
(1) 

 
In the pursuit of families of polynomials which are factorable in the set of integers and whose de-

rivatives are factorable in the set of rational numbers, it is amazing how much easier the process is 
when we incorporate an old trick from the remainder theorem.  I refer to taking the sum of all the nu-
merical coefficients.  If this sum is zero, then the number 1 is an automatic root; if not, it is not.  In 
essence, we plan to have one as a root by making sure that the selection of numerical coefficients add 
up to zero in any of the cubic or quartic forms.  In terms of the quintic, it does simplify this form to 
some extent, but Galois Theory promises that we will have irrational numbers in exact form. 
 

To begin, examine all three degrees in various forms with one as an automatic root and obtain new 
families of curves. 
 

Cubic Polynomials:  Form 3 2 ( )y ax bx b a x= − + −  
 

Quickly, ( )a b b a− + − is zero and so 1 is root (remainder Theorem).  Using synthetic division 
gives 

   1     a    -b     b-a             or       
2( 1) ( ( ) )

( 1) ( ( ))
x ax a b x
x x ax a b
− ⋅ + −

= ⋅ − ⋅ + −
 

                    a      a-b 
 a    a-b     0 
 
 

For integral roots, “b” needs to be a multiple of  “a” and this will guarantee that the original poly-
nomial is factorable. Now take the derivative and look for rational roots; this gives 
 

 
2

2

3 2 ( )
0 3 2 ( )
y ax bx b a

ax b x b a

′ = − + −

= − ⋅ + −
 

 
 

(2) 
 

Now test the discriminant 2 4B AC−  to determine values for which the polynomial is factorable. 
Here 2 , 3 ,B b A a= − =  and C b a= − and this gives   

2 2

2 2

2 2

4 ( 2 ) 4(3 )( )
4 12 12
4( 3 3 )

B AC b a b a
b ab a
b ab a

− = − − −

= − +

= − +

 

Here 4 is a perfect square, but 2 23 3b ab a− +  is a 
perfect square for a limited number of values. 

 
Fixing values of a in order to obtain values of b to make the expression 2 23 3b ab a− + , a perfect 

square, the following table is produced: 
 
 

[1]Diophantine Polynomials (Part 1) appeared in DNL#81.  
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TABLE I 
 
     Value of a          Resulting Polynomial            Corresponding Values of b 
 
 1  2 3 3b b− +    1, 2 

2  2 6 12b b− +    2, 4 

3  2 9 27b b− +    -2, 3, 6, 11 

4  2 12 48b b− +    4, 8 

5  2 15 75b b− +    -11, 2, 5, 10, 13, 26 

6  2 18 108b b− +    -4, 6, 12, 22 

7  2 21 147b b− +    -26, -1, 7, 14, 22, 47 

8  2 24 192b b− +    1, 8, 11, 13, 16, 23 

9  2 27 243b b− +    -47, -6, 9, 18, 33 

          10  2 30 300b b− +    -22, 4, 10, 20, 26 
 

In the interest of discovering single roots only, those values of b which are multiples of a are 
eliminated from consideration because we get double roots.  Thus no values of b work for 1a =  or 

2a = , but we do get values for b when 3a =  namely 2b = −  and 11b = .  There are obviously more 
values for b but do not consider them in order to keep the factors relatively small and easy to calculate.  
The above values are easy to spot on the TI graphing calculator by entering 2 3 3y x x= − + , and pressing 
2nd Function Table.   

Simply look for those values of y which are perfect squares. 

 
 

(3) 
 

An example of a cubic can be taken from TABLE I where a = 3 and b = 11.  This gives      

 
3 23 11 8y x x x= − +     

2(3 11 8)y x x x= ⋅ − +     
20 (3 11 8)x x x= ⋅ − +     
20 (3 3 8 8)x x x x= ⋅ − − +    

( )0 3 ( 1) 8 ( 1)x x x x= ⋅ ⋅ − − ⋅ −    

0 ( 1) (3 8)x x x= ⋅ − ⋅ −     
 

where 0, 1x x= =  and 8
3

x =    

      
 
and for the first derivative see next page. 
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3 2

2

2

3 11 8
9 22 8
9 18 4 8

0 9 ( 2) 4 ( 2)
0 (9 4) ( 2)

y x x x
y x x
y x x x

x x x
x x

= − +

′ = − +

′ = − − +
= ⋅ − − ⋅ −
= − ⋅ −

 

 

where 4 , 2
9

x x= = * 

* This gives rise to a new family of cubics whose original 
form and derivative form are both factorable. 
 
        Polynomial         Derivative 

( 1) (3 8)x x x⋅ − ⋅ −    ( 2) (9 4)x x− ⋅ −  
( 1) ( 2) (3 11)x x x− ⋅ − ⋅ −   ( 3) (9 13)x x− ⋅ −  
( 2) ( 3) (3 14)x x x− ⋅ − ⋅ −   ( 4) (9 22)x x− ⋅ −  
( 3) ( 4) (3 17)x x x− ⋅ − ⋅ −   ( 5) (9 31)x x− ⋅ −  

 
Quartic Form 

Moving on to the quartic form, examine 4 2 ( ).y ax bx b a= − + −   (We do not worry about missing 
consecutive powers of x because we can translate the above form either right or left and all the con-
secutive powers of x will appear.) 

Again examine the discriminate knowing that 1 is an automatic root.  
This becomes 2 2 2 2( ) 4( )( ) 4 4 ( 2 )b a b a b ab a b a− − − = − + = − .  Thus, the expression 4 2 ( )ax bx b a− + −  is 
always factorable regardless of the values for b and 2a.  

 

 

(4) 
 
Take the derivative, in order to see what values of a and b would make it factorable; this gives  
 

4 2

3

2

2

2

2

( )
4 2

0 2 (2 )
2 0, 2 0

2

2

y a x b x b a
y a x b x

x a x b
x a x b

a x b
bx
a

= ⋅ − ⋅ + −

′ = ⋅ − ⋅

= ⋅ ⋅ −

= ⋅ − =

⋅ =

=

 

In order to get integral roots, 
2
b
a

 must equal a perfect square such as 1, 4, 9, 16…  

Thus 

             
1, 4,9,16, 25...

2
2 ,8 ,18 ,32 ,50 ...

b
a

b a a a a a

=

=
  

 
So going back to the original 4 2 ( )y ax bx b a= − + − , substitute b = 2a and obtain 

4 2 4 22 ( 2 1)y ax ax a a x x= − + = − +  which gives double roots (disregard); letting b = 8a, 
4 2 4 2 2 28 7 ( 8 7) ( 7)( 1)y ax ax a a x x a x x= − + = − + = − −  which contains irrational roots.   
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Continue the search until rational roots appear (TABLE II). 
 
TABLE II 
 
     Value of b  Resulting Polynomial       Factors of Polynomial 
 
 2a  4 22ax ax a− +    4 2 2 2( 2 1) ( 1)a x x a x− + = −  

 8a  4 28 7ax ax a− +   4 2 2 2( 8 7) ( 1)( 7)a x x a x x− + = − −  

 18a  4 218 17ax ax a− +   4 2 2 2( 18 17) ( 1)( 17)a x x a x x− + = − −  

 32a  4 232 31ax ax a− +   4 2 2 2( 32 31) ( 1)( 31)a x x a x x− + = − −  

 50a  4 250 49ax ax a− +   4 2 2 2( 50 4 ) ( 1)( 49)a x x a a x x− + = − −  
 

 

(5) 
 
Here 2 2( 1) ( 49) ( 1) ( 1) ( 7) ( 7)a x x a x x x x⋅ − ⋅ − = ⋅ + ⋅ − ⋅ − ⋅ +  and the ensuing sequence for TABLE II   

1, 7, 17, 31, 49, … 22 1n −  does not yield any perfect squares for relatively small values  
but a new family of quartics is acquired because the derivative is also factorable at n = 7. 
 
or, 

  

4 2

3

2

( 50 49)

(4 100 )

(4 ) ( 25)
(4 ) ( 5) ( 5)

y a x x

y a x x

y a x x
y a x x x

= ⋅ − +

′ = ⋅ −

′ = ⋅ ⋅ −

′ = ⋅ ⋅ − ⋅ +

 

 
thus for  

  
0 (4 ) ( 5) ( 5)

0, 5, 5
a x x x

x x x
= ⋅ ⋅ − ⋅ +

= = = −
 

 
TABLE III reflects the new family of quartics and some of the family members.  It suffices to say 

that translation left or right can go on indefinitely, but the selection is limited to the list below because 
the numbers become large.  

TABLE III: 
 
             Family      Translated Form       Derivative 
 
(x – 1)(x + 1)(x – 7)(x + 7) x(x + 2)(x – 6)(x + 9)  4(x + 1)(x + 6)(x – 4) 
             (x + 1)(x + 3)( x– 5)(x + 9) 4(x + 2)(x + 7)(x – 3) 
             (x + 2)(x + 4)(x – 4)(x + 10) 4(x + 3)(x + 8)(x – 2) 
             (x + 3)(x + 5)(x – 3)(x + 11) 4(x + 4)(x + 9)(x – 1) 
             (x + 4)(x + 6)(x – 2)(x + 12) 4x(x + 5)(x + 10) 
             (x + 5)(x + 7)(x – 1)(x + 13) 4(x + 6)(x + 11)(x + 1) 
             x(x + 6)(x + 8)(x + 14)  4(x + 7)(x + 12)(x + 2) 
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(6) 

 
Quintic Form 
 

The best we can hope for here is a mix of rational and irrational numbers (single roots), but in ex-
act form (Galois Theory).  Again planting the root of 1, by making all the numerical coefficients add 
up to zero, examine 5 3 ( ) .y ax bx b a x= − + − .  A serendipitous result here is that  –1 is also a root just 

like in the quartic family of polynomials, (quartic form 4 2 ( )ax bx b a− + − ).  

 

In polynomial form, this yields 
 

 
5 3

4 2

( )
( ( ))

y ax bx b a x
y x ax bx b a
= − + −

= − + −
 

     
 
and 

        

2 2

2 2

2

4 ( ) 4 ( )
4 4

( 2 ) always factorable

B AC b a b a
b ab a
b a

− = − − −

= − +

= −

 

 
thus 

 

( )( )2

2

2

( 1)( 1)

( 1)( 1)

( 1)( 1) 1

1

1

y x x x ax b a

b
y x x x a x

a

b b
y a x x x x x

a a

= − + − −

= − + ⋅ −

= ⋅ − + − − +

  
 −    
  

−  
  

 

 

 

(7) 
 

So for integral roots, 1
b
a
−  must be a perfect square or  

 

1 1,4,9,16, 25,36, 49,64,81,100...

2,5,10,17, 26,37,50,65,82,101...

b
a
b
a

− =

=  

or 2 ,5 ,10 ,17 , 26 ,37 ,50 ,65 ,82 ,101 ...b a a a a a a a a a a=  
 
 
For an example: let 26b a=  then  
 

5 3 4 2 2 226 25 ( 26 25) ( 25)( 1) ( 5)( 5)( 1)( 1)y ax ax ax ax x x ax x x ax x x x x= − + = − + = − − = − + − +  
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In terms of the derivative 
 

 
5 3

4 2

( )

5 3

y ax bx b a x

y ax bx b a

= − + −

′ = − + −
 

 
 
and 2 24 ( 3 ) 4(5 )( )B AC b a b a− = − − −  

                       2 29 20 20b ab a= − +  
 
Finding values a and b for which the above is factorable gives rise to TABLE IV. 
 

 

(8) 
 
TABLE IV 
 
     Value of a  Resulting Polynomial   Values of b 
 
 1  29 20 20b b− +     -1, 1, 2 

 2  29 40 80b b− +     -2, 1, 2, 4, 11 

 3  29 60 180b b− +    -3, 3, 6 

 4  29 80 320b b− +    -4, 2, 4, 8, 11, 22 

 5  29 100 500b b− +    -22, -5, 5, 10 

 6  29 120 720b b− +    -6, 3, 6, 12, 33 

 7  29 140 980b b− +    -19, -7, -2, 7, 11, 14, 29 

 8  29 160 1280b b− +    4, 8, 16, 22, 44 

 9  29 180 1620b b− +    2, 9, 11, 18, 29 

          10  29 200 2000b b− +    5, 10, 20, 38 

         etc.    
 

Unfortunately, negative values of b in TABLE IV create complex roots in the original polynomial 
and multiples of “a” create double or triple roots.  Thus our choices are quite limited when stating 
new families.  Hence, there are no monic polynomials (a = 1) but there are families where 1...a ≠ → . 
A good example here is a = 9 and b = 29 and the analysis gives the following results: 

Here 

       5 3 4 2 4 2 2 2 2 29 29 20 (9 29 20) (9 9 20 20) (9 ( 1) 20( 1))y x x x x x x x x x x x x x x= − + = − + = − − + = − − −  
 
and the roots are 
 

2 20 ( 1)(9 20) ( 1)( 1)(3 2 5)(3 2 5)x x x x x x x x= − − = − + − +  
2 5 2 5

0, 1, 1, ,
3 3

x x x x x
−

= = = − = =  
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(9) 
 
for the derivative 
 

 

( )( )( )( )

5 3

4 2

4 2 2

2 2 2

2 2

9 29 20
45 87 20
45 75 12 20

0 15 (3 5) 4(3 5)
0 (3 5)(15 4)

0 3 5 3 5 15 2 15 2

y x x x
y x x
y x x x

x x x
x x

x x x x

= − +

′ = − +

′ = − − +

= − − −

= − −

= − + − +

 

 
 

 1
5 3 15

33 3
x = ⋅ =    2

5 3 15
33 3

x
− −

= ⋅ =  

  

 3
2 15 2 15

1515 15
x = ⋅ =   4

2 15 2 15
1515 15

x
− −

= ⋅ =  

 
 

The reader is left to develop other such families where 2, 3, 4 … are automatic roots.  These can 
all be achieved using the remainder theorem. 

 
 
 
Summary: 
 

The sole objective of this paper was to present both families of polynomials which are 
easily factored and methods by which to determine them.  The process is even easier if we 
plant 1, or 2, or 3 as roots making the original function factorable.  And, since the only two 
numerical coefficients are a and b, we can determine values of b easily while holding “a” 
constant.  Limiting the tables to small numbers is another effort to make successful curve 
sketching of polynomial functions more accessible to students of mathematics. 
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Last summer started an extended email exchange between Heinrich Ludwig and me. 
His mails are given below together with a summary in English. His Snub Cube turned 
out to be the starting point of an exciting journey into the world of polyhedrons. You 
are friendly invited to follow us. 

 
Von: Heinrich Ludwig [heinrich.ludwig@gym-raubling.de] 
Gesendet: Sonntag, 24. Juli 2011 11:27 
Betreff: DERIVE: Gefüllte Darstellung eines Vielecks im 3D-Fenster 
 
Lieber Herr Böhm, 

meine Frage klingt simpel, ich habe aber in allen DNLs, die in pdf-Version verfügbar sind, keinen 
Hinweis auf eine Antwort gefunden. 

Vielleicht könnten Sie mir weiterhelfen? 

Wie stellt man mit DERIVE 6 ein n-Eck (Eckenzahl n > 4) dessen Ecken dreidimensionale Koordina-
ten haben, als Fläche gefärbt im 3D-Fenster dar? (Natürlich müssen die Eckpunkte in einer Ebene 
liegen.) 

Für n=3 und n=4 habe ich eine Möglichkeit gefunden. Man bildet aus den Seiten des n-Ecks einen 
Vektor, wobei der Endpunkt der einen Strecke der Anfangspunkt der folgenden Strecke ist. Für n=5 
klappt das nicht mehr, denn intern behandelt DERIVE dieses Konstrukt so, dass zwei aufeinander 
folgende Strecken als Dreieck aufgefasst werden, welches flächig gefärbt dann dargestellt wird. 

Ich habe auch die Funktion POLY_FILL(u) ausprobiert, aber leider wird damit aus jedem Vieleck ein 
"Zebra", denn POLY_FILL unterteilt das Vieleck in Dreiecke, färbt diese verschieden ein und zeich-
net auch die Diagonalen des Vielecks, welche es in Dreiecke unterteilen, als schwarze Striche ein. 

Weil der Rechenaufwand zur Prüfung, ob ein Vieleck eben ist, beträchtlich sein dürfte (vermutlich n – 
2 Kreuzprodukte und n – 3 Tests auf Kollinearität der Normalenvektoren) nehme ich nach all meinem 
Ausprobieren an, dass DERIVE nur auf das Einfärben von Dreiecken eingerichtet ist. Ich wollte ar-
chimedische Körper nicht nur mit ihrem Kantengerüst, sondern als gefüllte Körper darstellen. Da wäre 
es schön gewesen, wenn man auch 4-, 5-, 6-, 8- und 10-Ecke hätte einfärben können. 

Eine Stelle im DNL fand ich, von der ich mir Hilfe versprochen hatte: Im DNL #77 haben Sie die 
Abituraufgabe mit DERIVE gelöst, die später den medienwirksamen Titel "Oktaeder des Grauens" 
erhalten hat. Das abgestumpfte Oktaeder haben Sie dann 3-dimensional dargestellt. 

Ich habe die Datei horror.dfw, die in gezippter Form dem Newsletter 
beilag, mit DERIVE geladen und die entsprechenden Zeilen, die die 
POLYGON_FILL-Funktion enthalten, zum Zeichnen verwendet. Und 
jetzt kommt das, was mir unverständlich ist: Bei Ihnen zeichnet POLY-
GON_FILL schöne einfarbige Polygone, bei mir aber diese "Zebras". 
Was läuft da verkehrt? Gibt es eine Einstellung, die DERIVEs Farb-
wechselschema steuert? Ich finde nirgends etwas Geeignetes in den Me-
nüs. Damit Sie sehen, was bei mir passiert, hänge ich ein Bild zu meinem 
Ergebnis an dieses Mail. 

 

The Zebra 

Ich höre jetzt auf mit meinen Nachforschungen und würde mich recht freuen, wenn Sie mir den ent-
scheidenden Tipp geben könnten. 

Mit besten Grüßen 
Ihr Heinrich Ludwig 
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Heinrich Ludwig’s problem from 24 July 2011 summarized: 

How can I represent a planar polygon (number of vertices n > 4) in 3D-space as a coloured 
area?  

I found a way for n = 3 and n = 4:  

One has to form a vector consisting of the edges of the n-gon with the endpoint of one side 
being the start point of the next one. But this does not work for n > 4, because DERIVE inter-
prets two subsequent segments as a triangle. 

Then I tried the function POLY_FILL(u) but unfortunately every polygon appears as a “ze-
bra”. POLY_FILL divides the polygon into triangles, dyes them in different colours and plots 
all sides of all triangles in black. 

I assume that DERIVE needs some calculation for testing if the points are lying in a common 
plane etc (which needs some cross products) and that the function is only intended for col-
ouring triangles. I wanted to represent Archimedean solids not only as a wireframe model but 
as a filled solid. It would be great to dye 4-, 5-, 6- 8- and 10-gons. 

I found one article in a DNL which promised some support. 

In DNL#77 you presented a truncated octahedron (“Octahedron of Horror”) using function 
POLYGON_FILL. I tried this function and I cannot understand what happened then: Your 
polygons are pretty one-coloured – and I received again “zebras”. What am I doing wrong? Is 
there a DERIVE setting which controls the colour change. 

I will stop now my investigations and would be happy if you could provide any hint. 

Sincerely Yours 

Heinrich Ludwig 

 

 

See my answer 

Dear Mr. Ludwig, 

Your “zebra” will change to a “grey donkey” or a “brown stallion” if you switch off option 
“Automatically change color of new plots” under Options > Display > Color. Plotting the bor-
ders needs some “manual work”: 

Perform a right mouse click on each triangle and the Edit-popup window will open: Choose 
Scheme: Custom, then choose the colour for the polygon and set the same colour for the 
mesh lines. 

Performing this procedure for all triangles should lead to the desired result. 

Best regards 

Josef 
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Von: Heinrich Ludwig [mailto:heinrich.ludwig@gym-raubling.de] 
Gesendet: Dienstag, 26. Juli 2011 23:15 
Betreff: kleines Dankeschön für Ihre Hilfe 

Lieber Herr Böhm, 

als kleines Dankeschön für Ihre freundliche Hilfestellung schicke ich Ihnen, wofür ich das Einfärben 
von Flächen verwenden wollte: einen archimedischen Körper. Mein Liebling ist der Cubus Simus. Er 
tanzt so schön aus der Reihe, ist eben nicht zentralsymmetrisch wie fast alle anderen. Außerdem zer-
fallen die Dreiecke unter den Seitenflächen des Cubus Simus topologisch in zwei Klassen, auch eine 
Besonderheit, die nur noch ein weiterer archimedischer Körper (das Dodekahedron Simum) hat. 

In den DNL-Heften, sowohl in den alten, die Sie neu als pdf aufgelegt haben, wie auch in den neueren, 
habe ich nichts Explizites zu archimedischen Körpern gefunden, insbesondere keine Koordinatensätze 
für die Ecken. Ich kann mir nicht vorstellen, dass es keinen schönen Beitrag dazu gegeben hat. Er wird 
wohl in einem der Hefte 26 bis 52 stehen, für die es keine pdf-Version gibt und die ich darum nicht 
kenne. Weil so ein Beitrag sehr wahrscheinlich schon erschienen ist, arbeite ich die Sache nicht weiter 
aus. Für Schüler ist der Cubus Simus eine zu harte Nuss. Nicht einmal meinem Schüler, der sich in 
seiner Seminararbeit mit der 3D-Darstellung verschiedener Körper beschäftigt, traue ich das zu. (Es 
gibt ja genügend viele einfachere Körper auch noch.) Aber weil das Wetter in den letzten Tagen gar so 
bedauerlich war, habe ich selber ein Objekt zum Spielen gebraucht. 

Der erste Schritt zur Konstruktion des Körpers war es, die Koordinaten der Ecken anzugeben. Ich 
wusste nur soviel über sie, dass sie auf die Seitenflächen eines Würfels gelegt werden können und 
dazu kannte ich die Symmetrien des Cubus Simus. Mit Hilfe zweier Parameter k und m, deren Werte 
noch zu bestimmen waren, konnte ich die Koordinaten formulieren. Der zweite Schritt bestand dann 
darin, die Ecken richtig miteinander zu verbinden. Dazu muss der Graph des Polyeders aufgestellt 
werden. Hat man beides, dann ist es nur noch eine Fleißaufgabe, die 38 Seitenflächen einzutippen. 

Da ich's ohnehin nur für mich aufbewahre, genügt mir eine handschriftliche Skizze, wie man zu den 
Eckpunktskoordinaten kommen kann. Den Graphen habe ich mit Herrn Hohenwarters Geogebra ge-
zeichnet (siehe Seite 25, Josef). 

Es wird an unserer Schule gern verwendet und ich selber nutze es auch recht gerne. 

Herzliche Grüße 

Heinrich Ludwig 

Heinrich Ludwig’s mail from 26 July 2011 summarized: 

As a little expression of thank I am sending an Archimedean solid. This was what I needed 
colouring areas for. My favourite solid is the Cubus Simus. It is pretty extraordinary because 
it is not central symmetric like almost all others. Additionally the faces are divided topologi-
cally in two classes. This is also a special feature only shared with one other Archimedean 
solid, the Dodecahedron Simum. 

I didn’t find any contribution on Archimedean Solids in earlier DNLs, in particular no sets of 
coordinates for the vertices. I wonder if there has no respective article appeared up to now. 
The Cubus Simus is a hard nut for students. Not even one of my students who works on a 
paper containing 3D-representations of various solids would be able to do this. (Fortunately 
enough there are many other easier solids, too.) 

Because of bad weather in the last days I needed an object to play with. 
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The first step for constructing the solid was to 
express the coordinates of its vertices. All what 
I knew was that they are located on the faces of 
a cube – and I knew the symmetries of the Cu-
bus Simus. Using two parameters k and m 
(their values had to be found) I could express 
the coordinates. (see my sketch). 

The second step was to connect the vertices 
(24) in the right way (60 edges forming 6 
squares and 32 triangles). This needs compos-
ing the graph of the polyhedron (see the Geo-
Gebra graph). The rest is some diligent work: 
entering the 38 faces of the solid. 

 
The GeoGebra Graph 

 

Der kronrandige Würfel, das abgeschrägte Hexaeder,  
Cubus Simus, Snub Cube 

Heinrich Ludwig, Germany 

Der Körper ist dem Würfel mit den Ecken [±1, ±1, ±1] einbeschrieben. Alle Ecken des Körpers liegen 
auf den Seitenflächen des Würfels. Die Koordinaten der 24 Ecken A bis X sind ±1, ±k oder ±m. Die 
genauen Werte für k und m werden unten hergeleitet. Es ist auch interessant zu sehen, wie sich der 
Körper verändert, wenn man k und m mit Schiebern variiert. Man kann auch ein Kubooktaeder oder 
ein kleines Rhombikubooktaeder erzeugen. 

The solid is inscribed a cube with vertices [±1, ±1, ±1]. All 24 vertices – A through X – lie in 
the faces of the cube with coordinates ±1, ±k or ±m. The exact values for k and m are de-
rived below. It is interesting to observe how the solid changes varying k and m by applying 
sliders. It is possible to create a cuboctahedron or a small rhombicuboctahedron. 
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                                  Cuboctahedron                                      Small Rhombicuboctahedron 

 
Here are the 24 vertices: 

 
 
These are the 6 squares followed by 32 triangles: 
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Calculation of appropriate values for k and m:  
 
The edges CA, AI and IC must be of equal length. 
 

  



   p 28   
 

Ludwig Heinrich: Cubus Simus – The Snub Cube  
  D-N-L#85  

  

 
 
Plotting all squares and triangles gives a wonderful representation of the snub cube. 

 
Hint: You can highlight and plot all expressions from ADBC:= to RBS:= in one single step. 
 
Comment: The values for k and m and closely related with the Tribonacci Constant c, which 
is the real solution of equation x3 –- x2 - x – 1 = 0. (c ≈ 1.839287) 
 
(Additional Comment: The Tribonacci Sequence is defined as an = an–1 + an–2 + an–3 for n ≥ 4 
with a1 = a2 = 1, a3 = 2. 

1, 1, 2, 4, 7, 13, 24, 44, …  

The ratio of adjacent elements tends to the Tribonacci Constant and the numbers of the se-
quence increase asymptotically to an ~ cn. 

(See also my additional comments at the end of this contribution, Josef) 
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Von: Josef Böhm [nojo.boehm@pgv.at] 
Gesendet: Samstag, 30. Juli 2011 13:25 
 
Dear Mr. Ludwig, 
 
I couldn’t resist colouring your pretty Cubus Simus, too. 

I did it in another way: First of all I produced the wireframe model of the solid (using your 
data together with GeoGebra-Graph). Then I copied and pasted the figure from the 3D-Plot 
Window into the Algebra Window. I converted this picture to a Paintbrush graph (Edit > Con-
vert Picture Object > Paintbrush Picture). Then I could fill all the faces in Paintbrush. The 
edges remain visible. As you can see I chose the visibility from the other side. 

 

JB 
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Von: Heinrich Ludwig [mailto:heinrich.ludwig@gym-raubling.de] 
Gesendet: Dienstag, 9. August 2011 13:11 
 
Lieber Herr Böhm, 

es freut mich, dass meine Spielereien Sie angeregt haben, damit weiter zu experimentieren. Ich habe 
auch schon daran gedacht, das Einfärben einem Programm zu überlassen, das sich auf graphische Be-
arbeitung besser versteht als Derive. Liefert Derive das Kantenmodell des Körpers, dann hat ein Gra-
phikprogramm alle Information, um die weitere Gestaltung zu übernehmen. Natürlich verliert man 
dabei, dass man auf einfache Weise den Augenpunkt wandern lassen kann, aber für eine statische Ab-
bildung des Körpers ist das nicht wichtig. 

Den von Ihnen beschriebenen Weg kann man noch ein wenig abkürzen, indem man den Graphikinhalt 
des 3D-Fensters mit Strg+C unmittelbar in die Windows-Zwischenablage kopiert und deren Inhalt 
dann vom Graphikprogramm einliest. Als solches bevorzuge ich GIMP. Es ist das am meisten ausge-
reifte OpenSource-Produkt auf dem Markt. 

Wussten Sie schon, dass 

 

Für Derive war die Vereinfachung des Terms leider ein zu harter Brocken. Wie kommt man aber auf 
so einen verrückten Term? Mich hat die Frage beschäftigt (das Wetter war allzu traurig in letzter Zeit), 
wie gut archimedische Körper rollen können. Das ist sicher eine eher physikalische Frage. Mein ma-
thematischer Ansatz war, den Raumwinkel an der Ecke des Polyeders zu betrachten. Nirgends konnte 
ich dazu eine Auflistung der Werte für die 5+13 archimedischen Körper finden, also habe ich Derive 
anpacken lassen. Derive musste die Formel von L'Huilier auswerten. Und dann kam für das Hexakisi-
kosaeder (4,6,10) das o.g. Ungetüm heraus. Jetzt wäre es freilich interessant, was die großen Compu-
teralgebrasysteme (Mathematica, Maple, etc.) leisten. 

Schaffen diese die Vereinfachung? Und was leistet der Derive-Nachfolger Nspire? 

Herzliche Grüße 

Heinrich Ludwig 

Heinrich Ludwig’s mail from 9 August 2011 summarized: 

Dear Mr. Böhm 
The procedure which you described can be shortened by copying the contents of the 3D-plot 
window into the clipboard (Ctrl+C) and then pasting into a graphics program. I prefer GIMP. 
For me it seems to be the best available open source program on the market. 

BTW, did you know that  
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It was a work too hard for DERIVE to simplify. But does one encounter such a crazy expres-
sion? I was busy treating the problem (weather was too bad in the last time) how good 
Archimedean solids can roll along. I know that this is more a physics question. My mathe-
matical approach was to investigate the space angle in an edge of the solid. As I could not 
find any list of these angles for the 5 + 13 Archimedean solids I engaged DERIVE to do the 
job. DERIVE had to evaluate the formulae of L’Huilier. And then there was the Hexakis Ico-
sahedron. It is the source of the onster from above. I would be very interested what the „big“ 
CAS like MATHEMATICA and Maple are able to do with it. 

Can they perform the simplification? And what about TI-Nspire? 

 

Dear Mr. Ludwig, 

Many thanks for your extended letter. Don’t underestimate DERIVE. It needs only setting the 
right mode for treating trig expressions: 

 

It is also interesting simplifying this expression piecewise: 
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or: 

 

You could also perform “stepwise simplification” in order to get some insight how DERIVE 
works internally. 

 

I add picture of the Hexakis Icosahedron. It 
is one of the Catalan solids which are dual to 
the Archimedean solids. 

The H.I. is the dual of the Great Rhombico-
sidodecahedron. 

(Source: the interesting kauernet-website 
from below.) 

Some additional comments: 

(1) Inserting sliders for k and m provides more insight in the influence of the parameters. 

 

 Challenge 1: Which combination of k and m create the solids given on page 26? 

(2) Another definition of the snub cube:  

 The solid whose vertices are the 24 points on the surface of a sphere for which the 
smallest distance between any two is as great as possible. 
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(3) Heinrich Ludwig had in the head line of his DERIVE file the expression Pentagonal 

Icositetrahedron. This is the “dual” solid to the snub cube. What are dual polyhedra? 

 The dual of a polyhedron can be found by connecting the midpoints of the edges sur-
rounding each vertex to a polygon and then constructing its tangent polygon (of the cir-
cumcircle). The numbers of vertices and faces interchange. The P.I. has 24 faces and 
38 vertices. 

 The dual solids of the Archimedean solids are the Catalan solids. 

 Challenge 2: Find the DERIVE model of the Pentagonal Icositetrahedron. 

(4) For our German readers: a snub nose is a “Stupsnäschen”. 
For all readers: “Simus” is a latin word for “abgeplattet” (German) and “flattened, oblate” 
(English). 

(5) The Tribonacci-sequence 

 

 

  

 The next page illustrates the properties of the Tribonacci constant. Finding a function 
for generating the Tribonacci sequence is left for the reader. 
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(6) A (small) selection of (many) interesting websites. (I didn’t add the Wikipedia sites 

which are also highly recommended.) 

http://arxiv.org/pdf/1202.0172v1.pdf 

http://www.ewetel.net/~neubauer/raumgeometrie/dateien/basteln/cubus%20simus%20basteln.pdf 

http://mathworld.wolfram.com/PentagonalIcositetrahedron.html 

http://kauernet.de/hendes/html/h306_catal.htm 

 

http://mathworld.wolfram.com/LHuiliersTheorem.html 

http://www.calculus.com/konfuciy.asp?tda=dt&t=966&fs=l%27huilier%27s+theorem 
  
(7) Finally, many thanks to Heinrich Ludwig for his inspiring contribution. 

(8) Most of my “knowledge” and some pictures presented above are from the internet. 

Josef 
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Statistics 
Visualising and Simulating Dynamically with TI-Nspire 3.1 

Guido Herweyers 
KHBO Campus Oostende 
guido.herweyers@khbo.be 

 
 
Introduction 
 
“Measuring is Knowing” is more important than ever nowadays. Wednesday 20 October 2010 
was the first “World Statistics Day” initiated by the UN. At this occasion the NIS (Nationaal 
Instituut voor Statistiek)[1] published a special extended version of the core numbers 2009 
with Belgium placed into an European perspective[2]. 

Technology proceeds and offers new possibilities for teaching. This is for sure for statistics. 
Actual data can be visualised quickly in various ways, simulations of random samples and 
experiments can be investigated. Doing so statistical concepts can be introduced early placing 
the data into the foreground and the formulae in the background. The intention of this paper is 
to demonstrate a possible way offering concrete examples. The statistical basic ideas are not 
defined here. The necessary background can be found in numerous statistics textbooks. 

Part 1 of this paper is to introduce the possibilities of TI-Nspire (version 3.1)[3], containing 
mainly descriptive statistics (2nd and 3rd grade in Belgium with two to four lessons mathemat-
ics a week). We are working with data from the web, too. 

Part 2 deals with simulating with TI-Nspire. How to select a simple random sample from a 
population? How does the normal distribution appear as probability distribution for the sam-
ple mean observing graphically the variability of more than 1000 sample means?  

Part 3 shows how to discover new probability distributions by simulation, starting with the 
uniform distribution on the interval [0,1]. We also treat the t-distribution. 

Part 4 demonstrates a possible approach for hypothesis testing supported by simulations. 

This paper can be downloaded (in its Flemish original) from the T3 Vlaanderen website,  

www.t3vlaanderen.be, 

together with the TI-Nspire files and all the data appearing in this paper. 

 

[1] NIS (Nationaal Instituut voor Statistiek) is the biggest statistical organisation of the Belgian 
government: http://statbel.fgov.be/nl 

[2] Kerncijfers 2009, België in een Europees perspectief  
http://economie.fgov.be/nl/modules/pressrelease/statistieken/generale/world_statistics_day.jsp 

[3] Information about TI-Nspire: www.education.ti.com 
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Part 1: Descriptive Statistics 

(1) Qualitative ungrouped data 
 
Open TI-Nspire, close the welcome screen and insert a page with the Lists & Spreadsheet Applica-
tion (which is one of seven applications offered): 

 
 
Example 1: 

Given are the eye colours of 15 persons: green, blue, blue, grey, blue, green, brown, blue, grey, brown, 
blue, green, blue, blue and grey. 
→ Name the first column A as eye_colour. 
→ Enter the colours (begin in cell A1) one after another – under quotes because the data are strings. 
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→ Select the whole column (left mouse click on letter A), then choose the first menu  (Docu-
ment Tools) in the Document Toolbox. Choose option 3: Data > Quick Graph. The window will 
split and you will receive a Dot Plot in the right window. 

 
→ Choose the right window (left mouse click on the window) and change the diagram to a Pie Chart. 
Another (right) mouse click on the pie offers presenting the percentages (Show all Labels). Hovering 
the mouse over the sectors of the pie opens a small window showing details. 

 
The context menu (right mouse click) enables quick performing appropriate actions. You can close a 
window by selecting it (left mouse click), pressing Ctrl + K followed by pressing the Del(ete)-key. 
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→ Change the diagram to a Bar Chart (right mouse click in the right window).  

Shift the category brown to the right (left mouse click on the label brown and drag it to the right). 

   
 

Right mouse click pop up menu offers three 
ways of sorting the bars.  

 

→ Add another column containing the gender of the persons. and then split the category of the eye 
colour with respect to the second category gender. (Right click on the X-variable eye_colour, select 
option 4: Split Categories per Variable and select gender.)  
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→ Insert a Calculator page via Insert from the Menu bar. 

 

→Type eye_colour followed by pressing the ENTER-key. The variable eye_colour is a list of 
strings. The command countif(eye_colour,?=,”blue”) gives the number of appearances of “blue” in 
this list. 

 

Hint: The size of the characters can be adapted by using the slider bar on the bottom of the 

screen:    

 

(2) Qualitative grouped data 
 
Example 2: 

On the NIS website one can find the distribution of the use of ground in Belgium (2009) 

 
(agriculture, permanent pastures and grassland, woods, others and water, tilled areas) 

→ Insert a new spreadsheet page and fill in the data. 
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→ Insert a new spreadsheet page and fill in the data. 

 

 

 

 

 

→ Activate the right window. Bring the bars to a decreasing order by the menu Actions > Sort > 
Value Order. You can also shift the bars respectively. 
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Then change the bar chart to a pie chart via the Plot Type menu (or by a right mouse click on one of 
the bars). 

   

The statistics diagrams appear in a Data & Statistics Application. You could also start by inserting 
this application into a separate page, then use the Plot Properties menu, select Add X Variable 
(ground) and finally select Add Y Summary List (square_km). 

  

But it works really faster by a rmcl (right mouse click) on Click to add variable on the window bot-
tom and then choosing Add X Variable with Summary List. 
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→ Save the file as statistics (Menu File > Save as). 

Open menu Page Sorter   in the Documents Toolbox. Rename the standard name Problem 1 
as Qualitative Variables by a rmcl on Problem 1. 

       

One file can contain various problems, with each problem containing more pages (which can be se-

lected in the Page Sorter ). Each page can consist of maximum four applications (seven applica-

tions are available). Each application has its own menu which is available under  in the Docu-
ments Toolbox. 

Within one problem a variable has the same value on all pages. Variable x in one problem is inde-
pendent of variable x in another problem. 

 
 
Example 3: 

Belgium consists of three districts (constituent states): the Flemish district (Vlaams Gewest), the Brus-
sels Capital Town district (Brussels Hoofstedelijk Gewest) and the Wallonian district (Waals district). 
The German speaking minority (Duitstalige gemeenschap) is part of the Waals district. 

The population numbers from 2005 to 2010 were (according NIS): 

 

Gewest 2005 2006 2007 2008 2009 2010 

Brussels H. Gew. 1.006.749 1.018.804 1.031.215 1.048.491 1.048.491 1.089.538

Vlaams Gewest 6.043.161 6.078.600 6.117.440 6.161.600 6.208.877 6.251.983

3.395.942 3.413.978 3.435.879 3.456.775 3.475.671 3.498.384Waals Gewest 

waarvan 

Duitstalige gem. 75.512 73.119 73.675 74.169 74.540 75.222

 

→ Create a bar chart comparing district populations of the years 2005 and 2010. 
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Hint: you can add different Add Y Summary Lists with one X-variable given (via Plot Type in the 

Data & Statistics Documents Toolbox . 

 
 

 

 

Our USER Forum 
 
On 07/01/12 13:53, Giuseppe Ornaghi wrote: 
I am using Derive 6.10 for Windows and I would like to know if it is possible to plot the absolute 
value of the zeta function in a range. 
Thank you very much. 
Giuseppe 
 
Hi Giuseppe, 

try ABS(ZETA(x+i*y)) as a 3-d plot. You will get a surface in R^3 defined by 
[x,y,ABS(ZETA(x+i*y))]. I hope this is what you were looking for. 

Stefan Welke 
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With ABS(ZETA(x+i*y)) I get the error message:Too many variables.With z=ABS(ZETA(0.5+i*y)) I 
get a surface in 3D. I would like to plot ABS(ZETA(0.5+i*y)) on a xy plane (x-axis corresponds to the 
values of y and y-axis to the absolute value of ZETA(0.5+i*y)). 
Is it possible? 
Thank you very much. 
Giuseppe 
 

Hello Giuseppe, 

did you use the "i" from the menu in the bottom? If not, then "i" from the keyboard will be interpreted 
as a variable, and then there are three, which is one too much. Alternatively try ABS(ZETA(x+#i*y)) 
as input. This will work correctly. I assume, that you will now see a surface different from that of your 
previous attempt. 

Cordiali saluti, Stefan Welke 

 

                                                       
 
I see a surface different from previous examples. Thank you. 
And for my attempt to plot a graph in xy-plane? 
Thank you very much. 
Saluti dall'Italia. 
Giuseppe 

 

 
(symmetric wrt y-axis) 
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TIME 2012 – The Keynotes, Lectures and Workshops 

List of presentations (in alphabetical order) of accepted proposals. It is very 
likely that more will follow. All continents will be present in Estonia in July.  

 
A Stepwise Graphical Approach for Teaching Automated Theorem Proving in Engi-
neering 
A Tool for Evaluation of Rationality of Algebraic Transformations  
Adapting the Assessment to the Instrumental Genesis 
Adopting TI-Nspire CAS Technology (Handheld and Software), a Campus-Wide Ex-
perience 
An Evaluation of Students: Experiences in Technology-based Courses in Mathemat-
ics and Statistics 
Attracted by (Strange) Attractors 
Being a Math Teacher – Looking through the Blog Posts of Student Teachers (Key-
note) 
CAS in the Classroom: Yesterday, Today, and Tomorrow (Keynote) 
CAS or not CAS? that is the question when using technology in  math education 
Changing Assessment Methods: New Rules, New Roles 
Compound Damped Pendulum: an Energy Comparison 
Computer Algebra as an Educational Tool 
Critical Issues of Effective CAS Utilization (Keynote) 
Deriving Big Formulas with Derive and What Happened Then 
Determining the Proof Skills of 2nd Year Preservice Mathematics Teachers by 
Means of GeoGebra 
Development of Pedagogical Tools for Teaching Mathematics from the PC Lab to 
Smartphone (Keynote) 
Dynamic Systems – From Simulation Software to CAS (WS) 
Dynamic Systems - Many Competences - Presented Dynamically 
Experiences of 15 Years Using Graphic Calculators in Saxonia 
Finding Bioinformatics Data and DERIVE Programs to Process it (WS) 
Find your very own "attractive" Attractor 
Finnish Upper Secondary Students' Collaborative Processes in Learning Statistics in 
CSCL Environment 
From Inductive Reasoning to Proof by Induction with Geometry Expressions (WS) 
From Vienna to Tartu: A 10 Years Tour using DERIVE in TIME (Keynote) 
Hidden Markov Models and an Introduction to Their Uses in Bioinformatics 
High School Students' Acquisition of Knowledge and Skills through Self-Organization 
and Collaboration 
Integration of Digital Tools into the Mathematics Classroom: A Challenge for Prepar-
ing and Supporting the Teacher 
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Invariant Region Method (IRM) Applied to Two Dimensional Predator-Prey Systems 
Learning Mathematics through the Surrounding World 
Making Learning Math Addictive - Localization of the Famous Open Source Website 
Khan Academy in Estonia 
Mathematical Induction and CAS 
Mathematical Modelling with Geometry Expressions and TI-Nspire CAS 
Math eTextbooks 
Media Diversity Project – E-Learning Paths in Maths Education 
Modeling the Probability of a Binary Outcome 
Motion Sensors in Mathematics Teaching: Learning Tools for Understanding General 
Math Concepts? 
Notice Mathematics around You 
Programming-like Activities for Calculus and Differential Equations Classes 
Prospective Teachers' Curriculum Strategies in CAS-based Written Lessons 
Representations of Solids and Surfaces within the TI-Nspire Environment  
Systems of Computer Algebra and Dynamic Geometry as Tools of Mathematical  
Investigation 
Teaching conics through mathematical modelling (WS) 
Technology in Maths (a Queensland Perspective) 
The Effects of Using a Calculator on Reducing Mathematics Anxiety 
Types of Mistakes and Dynamics of the Occurrence of Mistakes Solving Linear 
Equations Using Computer Program T-algebra 
Using Derive To Generate DNA Fractal Representations 
Using Dynamic Documents to Enhance Student Understanding 
Using Fourier Series to Analyse Mass Imperfections in Vibratory Gyroscopes 
Using TI-Nspire CAS Technology in Teaching Engineering Mathematics: ODE's 
Using TI-Nspire CAS Technology in Teaching Engineering Mathematics: Calculus 
Visualizing and Understanding Statistical Concepts with TI-Nspire 
What was Special in DERIVE? 
When do Computer Algebra Systems Offer Unexpected Answers to School Equa-
tions? 
Why Trying to Avoid Using Complex Numbers? 
 

DUG-Meeting 2012 
 

For more Information and Registration: 
http://www.time2012.ut.ee/ 

 


